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1. Siapakah pegawai yang akan mengunci masuk dan menyemak data sistem 

MyCost di peringkat PTJ? 

 

Jawapan 

 

Bahagian Akaun menyarankan agar dua (2) orang pegawai kewangan / akaun 

(terdiri daripada seorang (1) pegawai Pengurusan & Profesional dan seorang (1) 

pegawai pelaksana) yang akan mengunci masuk dan menyemak maklumat di 

sistem MyCost. 
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1. Apakah Sistem eVendor? 

 

Jawapan 

 
 

Sistem pendaftaran untuk pembekal dan individu yang berurusan dengan kerajaan 

yang tidak berdaftar dengan sistem ePerolehan. 

 
 

2. Siapakah pengguna Sistem eVendor? 
 

 

Jawapan 

 
 

i) Pembekal yang berdaftar dengan Suruhanjaya Syarikat Malaysia (SSM). 

Pembekal kategori ini boleh membuat pendaftaran secara online di Sistem 

eVendor. 

 

ii) Pembekal bukan Suruhanjaya Syarikat Malaysia (SSM) yang berdaftar 

dengan Pendaftar Pertubuhan Malaysia (ROS), Suruhanjaya Koperasi 

Malaysia (Koperasi), Pendaftar Perniagaan (ROB) dan lain-lain. Pembekal 

kategori ini perlu membuat pendaftaran secara offline terlebih dahulu di 

Pejabat Perakaunan dengan mengisi Borang Pendaftaran eVendor dan 

mengemukakan bersama dokumen sokongan. 

 

iii) Penerima individu iaitu Payee Non Supplier (PANS) yang tidak terlibat 

dengan transaksi Arahan Pembayaran Pendapatan Bercukai dan tidak 

didaftarkan di dalam vendor Master Data iGFMAS. Penerima kategori ini 

perlu membuat pendaftaran secara offline terlebih dahulu di Pejabat 

Perakaunan dengan mengisi Borang Pendaftaran eVendor dan 

mengemukakan bersama dokumen sokongan. 
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3. Bagaimanakah cara untuk mendaftar/mencipta insiden di Solman Services Desk? 

 
 

Jawapan 

 
 

i) Log in iGFMAS Portal (Daftar masuk sebagai pengguna). 

 

ii) Klik ‘IGFMAS Services Desk’. 

 

iii) Klik ‘IT Services Management’ kemudian pilih ‘Create Incident’. 

 

iv) Lengkapkan butiran dan ruangan wajib:- 

 Description. 

 Support Team ID. 

 Kementerian. 

 Pegawai Pegawal. 

 Kod Kumpulan PTJ & PTJ. 

 Category (Category 1 dan 2). 

 Type of Complain. 

 Processing Data: Status ‘New’, isikan ruangan ‘Urgency’ dan 

‘Priority’. 

 Text: isikan penjelasan mengenai isu / masalah. 

 Attachment : Upload masalah / print screen 

 

v) Klik butang ‘Save’  (akan keluar no. insiden dan secara automatik notifikasi 

insiden akan dihantar ke emel 1st Level Support). 
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4. Apakah tindakan yang perlu diambil oleh PTJ setelah menerima syor/cadangan 

penyelesaian daripada Solman Services Desk? 

 
 

Jawapan 

 

i) Log in iGFMAS Portal (Daftar masuk sebagai pengguna). 

ii) Klik ‘IGFMAS Services Desk’. 

iii) Cari dan Klik ‘No. Incident’ yang telah dilaporkan. 

iv) Klik  butang ‘Edit’ 

v) Tukar status di Processing Data samada : 

 Customer Response 

(Maklumbalas daripada pengguna ke atas status “Customer Action”) 

 Customer Verification 

(Maklumbalas daripada pengguna ke atas status “Proposed 

Solution” - masalah yang dilaporkan masih belum selesai ) atau 

 Confirm 

(Incident telah selesai) 

vi) Klik butang ‘Save’ 

 

 

5. Bagaimanakah cara untuk mengaktifkan token GPKI MAMPU? 

 

Jawapan 

 
 

i) Klik ikon MAMPU GPKI Agent 2.0 untuk pengaktifan agen. 

ii) Pilih menu ‘Pengurusan Token’ seterusnya ‘Pengaktifan Token’. 

iii) Masukkan No. Mykad dan klik ‘hantar’. 

iv) Lengkapkan maklumat pengaktifan token dan klik ‘hantar’. 

v) Mesej transaksi berjaya dipaparkan. Klik OK untuk tutup. 
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6. Bagaimanakah cara untuk memperbaharui Sijil Digital Individu? 

 

Jawapan 

 
 

i) Notifikasi diterima melalui emel secara berperingkat iaitu 30 hari, 15 hari dan 

sehari sebelum Sijil Digital tamat tempoh. Laksanakan pengaktifan lebih awal 

sebelum tamat tempoh bagi mengelakkan gangguan capaian. 

ii) Gunakan kod pengaktifan yang diterima di dalam emel yang bertajuk 

‘Notifikasi Tempoh Sah Sijil Digital’ yang terkini. Akses Portal GPKI di 

https://gpki.mampu.gov.my 

iii) Klik menu ‘PERKHIDMATAN’ > Kategori ‘Permohonan Sijil Digital Individu’ > 

Permohonan Sijil Digital Individu. 

iv) Masukkan No. Mykad pengguna, kod pengaktifan dan klik ‘seterusnya’. 

v) Borang permohonan yang lengkap diisi dipaparkan. Kemaskini maklumat 

sekiranya ada dan klik ‘Hantar’. 

vi) Status pengesahan permohonan berjaya dihantar dipaparkan. Tekan ‘Cetak’ 

untuk paparan borang yang berjaya dihantar. 

vii) Borang permohonan dipaparkan dan sedia dicetak. 

viii) Status permohonan terkini boleh disemak melalui Portal GPKI melalui menu 

‘PERKHIDMATAN’ > Kategori Permohonan Sijil Digital Individu > Semak 

Status Sijil. 

 
 

7. Apakah jenis saluran terimaan ePembayaran yang boleh dilaksanakan di PTJ? 

 

Jawapan 

 
 

PTJ boleh melaksanakan terimaan melalui e-Pembayaran melalui saluran berikut; 
 

i) Terminal Kad Pembayaran (Point-Of-Sales (POS)) di kaunter menggunakan 

kad kredit, kad debit/mydebit atau kad AMEX (P.S. 2.1); 
 

ii) Portal Kementerian atau Jabatan melalui sistem yang dibangunkan dan 

mempunyai saluran pembayaran FPX. Pindahan secara online melalui 

kaedah EFT, kad kredit atau kad AMEX. (P.S. 2.2.); dan 
 

iii) Perbankan internet mudah alih termasuklah pindahan secara online melalui 

kaedah EFT, kad kredit, kad AMEX dan JOMPAY (P.S. 2.3). 

https://gpki.mampu.gov.my/
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8. Bagaimanakah PTJ boleh untuk menggunakan/melaksanakan saluran terimaan 

melalui ePembayaran? 

 

Jawapan 

 

PTJ perlu menentukan saluran terimaan yang bersesuaian digunakan terlebih 

dahulu dan mengambil tindakan berikut: 
 

 

 

 

9. Sekiranya sebelum ini PTJ pernah mempunyai ATKP yang telah tidak aktif, 

bolehkah PTJ memohon ATKP yang baharu? 

 
 

Jawapan 
 
 

PTJ perlu menghantar permohonan untuk penutupan ATKP yang tidak aktif dan 

nyatakan sebab-sebab penutupan sebelum permohonan baru boleh diproses. PTJ 

hendaklah menyemak samada terdapat ATKP di PTJ masing-masing yang tidak 

aktif/tidak diperlukan dan mengambil tindakan. 

JENIS SALURAN TINDAKAN 

Terminal Kad 

Pembayaran (Point-Of-

Sales) 

i. Berurusan dengan Bahagian Kewangan, KKM bagi 

penentuan Acquiring Bank (AB); dan 

ii. Melantik AB bagi pembukaan Akaun Terimaan Kecil 

Perbendaharaan (ATKP) dengan mengangkat 

permohonan pelantikan AB ke Bahagian Akaun dan 

akan dipanjangkan ke JANM untuk kelulusan. 

Portal Kementerian atau 

Jabatan 

i. Mendapat kelulusan reka bentuk sistem yang 

dibangunkan dari JANM; dan 

ii. Menentukan dan melantik Acquiring Bank (AB) bagi 

pembukaan Akaun Terimaan Kecil Perbendaharaan 

(ATKP) dengan mengangkat permohonan pelantikan 

AB ke Bahagian Akaun dan JANM untuk kelulusan. 

Perbankan internet (online 

banking) 

Menentukan dan melantik Acquiring Bank (AB) bagi 

pembukaan Akaun Terimaan Kecil Perbendaharaan (ATKP) 

dengan mengangkat permohonan pelantikan AB ke 

Bahagian Akaun dan JANM untuk kelulusan. 
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10. Apakah kriteria sistem terimaan di KKM yang memerlukan kelulusan reka bentuk 

dari Jabatan Akauntan Negara Malaysia (JANM)?  

 

Jawapan 

 

Sistem terimaan di KKM yang memerlukan kelulusan reka bentuk dari JANM 

termasuklah proses pengeluaran bil/invois, terimaan (pengeluaran resit), 

pengurusan Akaun Belum Terima (ABT), pengurusan amanah, pengurusan 

deposit dan pengurusan panjar khas. 

 

11. Sekiranya terdapat penambahbaikan atau perubahan pada rekabentuk sistem 

sedia ada yang telah mendapat kelulusan JANM, adakah permohonan baharu 

perlu dikemukakan semula? 

 

Jawapan 

 
 

Ya. Sekiranya terdapat penambahbaikan atau perubahan pada rekabentuk sistem 

yang asal maka permohonan baharu perlu dikemukakan semula. 

 

12. Sekiranya PTJ ingin menukar payment gateway bagi sistem yang telah 

dibangunkan, adakah permohonan kelulusan baharu perlu dikemukakan atau 

memadai dengan surat pemakluman pertukaran payment gateway sahaja? 

 

Jawapan 

 

Tiada keperluan pemakluman atau kelulusan baharu oleh JANM bagi pertukaran 

payment gateway untuk sistem yang telah dibangunkan dengan syarat tiada 

perubahan rekabentuk ke atas sistem tersebut. Namun begitu, pihak PTJ adalah 

dikehendaki untuk memastikan lantikan Payment Gateway Provider adalah 

tertakluk kepada Pekeliling Perbendaharaan P.S. 2.2. 
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1. Sekiranya pemandu kenderaan (H11) diarahkan menghantar wang kutipan dari 

Pemungut Kecil ke Pemungut Utama, adakah Surat Kebenaran Kuasa Secara 

Bertulis diperlukan? 

 

Jawapan 

 

Ya. Pemandu kenderaan (H11) perlu diberikuasa secara bertulis oleh Ketua 

Jabatan (Pemungut Utama) dalam menjalankan tugas berkaitan pengurusan 

terimaan.  

 

2. Apakah laporan terimaan yang perlu dicetak dan disemak oleh Pejabat 

Pemungut? 

 

Jawapan 

 

Senarai laporan terimaan yang perlu dicetak dan disemak secara harian dan 

bulanan adalah seperti berikut:- 

 

 

 

 

 

DICETAK HARIAN DICETAK BULANAN 

Buku Tunai Cerakinan Harian - AP 80 (b) Laporan Invois Terperinci 

Laporan Terimaan Mel (Harian) - AP 71 (e) Laporan Resit Batal 

Laporan Serahan Wang Laporan Terimaan Mel (Bulanan) 

Penyata Pemungut - AP 79 (a) 
Laporan Ringkasan/Terperinci Tempoh 

Usia Hutang 

Baucar Jurnal 
Laporan Tempoh Proses Penyata 

Pemungut 

 Laporan Mengikut Kod Jenis Terimaan 
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3. Adakah Pejabat Pemungut Kecil bertanggungjawab untuk menyelenggara buku 

tunai kew.249 dan kew.68? 

 

Jawapan 

 

Ya. Pihak yang bertanggungjawab untuk menyelenggara Buku Tunai kew.249 dan 

kew.68 adalah pejabat pemungut yang diberikuasa secara bertulis untuk mengutip 

hasil dimana urusniaga tersebut berlaku termasuklah pejabat pemungut kecil di 

Klinik Desa dan Klinik Komuniti yang diberikuasa. 
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i. Kategori: Bayaran  

 

1. Bagaimanakah PTJ hendak memastikan semua tanggungan perbelanjaan yang 

telah dibuat penerimaan bekalan & perkhidmatan (FRN (eP) / GRN (iGFMAS)) 

diselesaikan dalam tempoh yang ditetapkan dalam tahun semasa? 

 

Jawapan 

 
 

PTJ hendaklah membuat pemantauan FRN/GRN yang belum selesai di portal 

sistem iGFMAS melalui semakan laporan - laporan berikut secara berkala: 

i. Laporan Pesanan Kerajaan (semua status) 

ii. Laporan Tanggungan Belum Selesai Pesanan Kerajaan 

iii. Laporan Terperinci Pesanan Kerajaan Yang Telah Lengkap (semua 

transaksi bagi PO status 80) 
 

PTJ perlu memastikan semua Arahan Pembayaran diselesaikan sehingga ada 

nombor EFT. Pembayaran hendaklah menggunakan Arahan Pembayaran 

Dengan Pesanan dan tidak boleh menggunakan Arahan Pembayaran Tanpa 

Pesanan.  

 

Sekiranya FRN/GRN tersebut telah dibuat menggunakan Arahan Pembayaran 

Tanpa Pesanan kerana masalah sistem yang tertentu, FRN/GRN tersebut perlu 

dibatalkan oleh PTJ dalam tahun semasa. 

 
 

2. Pembekal kerap menghubungi PTJ bagi mengenalpasti pembayaran EFT yang 

telah dibuat.  Bagaimanakah caranya untuk pihak pembekal mengenalpasti 

pembayaran EFT yang diterima? 

 

Jawapan 
 
 

PTJ boleh memaklumkan pembekal untuk membuat carian di laman web 

https://emaklum.anm.gov.my/ menggunakan no. pendaftaran syarikat. 

 

PTJ perlu mencatatkan no invois/tarikh invois dan perihal perkhidmatan/bekalan 

dengan lengkap di perihal arahan pembayaran seperti berikut: 
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Perihal bayaran: No. Invois / Tarikh Invois - Perkhidmatan / bekalan… 

 

 

Catatan perihal seperti di atas memudahkan pembekal mengenalpasti 

pembayaran yang telah dibuat bagi invois yang berkenaan di eMaklum. 

 

3. Sekiranya pembayaran utiliti dibuat secara baucar berasingan iaitu melalui Arahan 

Pembayaran Modul Invois Tanpa Pesanan Kerajaan oleh PTJ, apakah kod 

pembekal yang digunakan bagi pembayaran utiliti tersebut? 

 

Jawapan 

 
 

Pembayaran utiliti yang dibuat bagi jenis bayaran secara baucar berasingan 

hendaklah menggunakan kod pembekal 6000xxxxx manakala kod pembekal 

20000xxxxx digunapakai bagi pembayaran pukal diperingkat Pejabat Perakaunan. 

 

4. Adakah Arahan Pembayaran dengan Pesanan Kerajaan (eP) tanpa tambahan caj 

line akan melalui proses semakan AO sebelum boleh diperaku II? 

 

Jawapan 

 

Tidak. Arahan Pembayaran dengan Pesanan Kerajaan (eP) tanpa tambahan caj 

line (kecuali potongan CDC) akan terus terpapar di Senarai Tugas Harian pegawai 

Peraku II tanpa memerlukan semakan AO. 

 

Arahan Pembayaran dengan Pesanan Kerajaan akan disemak oleh Pejabat 

Perakaunan (AO) sekiranya ada potongan seperti berikut:- 

i. Penalti 

ii. Royalti 

iii. Bayaran Balik Wang Pendahuluan Kontraktor 

iv. Potongan Tetap 

v. Potongan Tidak Tetap 

vi. Wang Jaminan Pelaksanaan 
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Berikut adalah perbezaan proses semakan AO untuk Arahan Pembayaran dengan 

Pesanan Kerajaan bagi eP dan iGFMAS: 

 

Item yang disemak oleh 

AO 

Arahan Pembayaran dengan 

Pesanan Kerajaan (eP) 

Arahan Pembayaran dengan 

Pesanan Kerajaan (iGFMAS) 

CDC X √ 

PENALTI √ √ 

ROYALTI √ √ 

WPK √ √ 

POTONGAN TETAP √ √ 

POTONGAN TIDAK 

TETAP 
√ √ 

WJP √ √ 
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ii. Kategori: Gaji 

 

1. Apakah tindakan PTJ bagi membolehkan baucar bayaran (tuntutan perjalanan dan 

elaun lebih masa) disediakan kepada pegawai yang maklumatnya tiada dalam 

sistem ECP iGFMAS? 

 

Jawapan 

 

PTJ perlu memastikan borang Pendaftaran/Penamatan Penerima Bayaran 

iGFMAS, salinan penyata bank yang telah disahkan dan salinan PA30 yang dijana 

dalam sistem HCM dikemukakan ke Unit Gaji, Bahagian Akaun untuk 

memasukkan data pegawai tersebut ke dalam sistem iGFMAS. 

 

2. Bagaimanakah untuk menyemak dan mengelakkan kesalahan pembayaran gaji 

kepada pegawai yang telah bersara/letak jawatan? 

 

Jawapan 

 

PTJ hendaklah memastikan proses kerja bagi persaraan dan peletakan jawatan 

dilaksanakan mengikut SOP yang ditetapkan bagi membolehkan Penyata Kew. 

8 dan Borang SG20 untuk penamatan dan pemberhentian gaji disediakan lebih 

awal atau sebaik sahaja pegawai bersara dan tidak lagi berkhidmat dengan 

Kerajaan Persekutuan. SOP yang disediakan hendaklah berdasarkan semua 

Pekeliling dan peraturan yang berkuatkuasa dengan menetapkan tempoh bagi 

membolehkan pembayaran gaji dihentikan pada tarikh pegawai tidak lagi 

berkhidmat dengan Kerajaan. 

 

PTJ hendaklah menyemak laporan-laporan gaji termasuklah Laporan ZRPY108 

yang dikemukakan oleh AO/JANM bagi memastikan tarikh persaraan pegawai 

yang akan bersara adalah tepat dan betul. Sekiranya terdapat kesilapan, PTJ 

hendaklah memaklumkan kepada AO dan seterusnya membuat pembetulan di 

dalam sistem HCP iGFMAS.  PTJ juga hendaklah membuat semakan samada 

masih terdapat pegawai yang tidak layak dibayar gaji di Laporan Payroll Master 

Listing pada setiap bulan. 
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3. Apakah tindakan yang boleh diambil bagi mengelakkan pembayaran terlebih 

emolumen kepada kakitangan yang sedang dalam tindakan disiplin? 

 

Jawapan 

 

PTJ hendaklah mengambil tindakan dengan merujuk kepada Panduan Mengurus 

dan Melaporkan Tindakan Tatatertib Kementerian Kesihatan Malaysia dan 

mengeluarkan pegawai berkenaan dari sistem payroll HCM dengan serta merta. 

 

4. Apakah tindakan yang perlu dibuat bagi memastikan amaun potongan cukai 

adalah tepat sekiranya berlaku perubahan tanggungan / kelayakan kadar 

potongan cukai / status perkahwinan walaupun pegawai telah mengemaskini 

maklumat tersebut di sistem HRMIS? 

 

Jawapan 

 

Pegawai hendaklah mengemaskini borang Potongan Cukai Berjadual (PCB) dan 

mengemukakan ke Unit Gaji PTJ untuk dikemaskini di dalam sistem HCM kerana 

sistem HRMIS masih belum berintegrasi dengan sistem HCM. 

 

 

 

 

 

 

 

 

 

 

 

 



FREQUENTLY ASK QUESTION| FAQ 
 

21 |  BAHAGIAN AKAUN, KEMENTERIAN KESIHATAN MALAYSIA 

 

iii. Kategori: Amanah, Deposit, Panjar & Subsidiari 

1. Bagaimanakah cara untuk menyelenggara baki Akaun Amanah di PTJ? 

 

Jawapan 

 

i. Laporan berikut hendaklah dijana melalui Portal iGFMAS di bawah modul 

laporan dan sub modul Laporan Aset / Liabiliti / Ekuiti / Belanja / Hasil  

 Laporan Liabiliti / Ekuiti  

 Laporan Belanja  

 Laporan Hasil 

 

ii. Selenggara Daftar Ringkas Manual Baki Amanah bagi mendapatkan Baki 

Amanah Harian/Bulanan.  

 

Untuk mendapatkan tatacara yang lebih terperinci, sila rujuk Surat Edaran 

tahun 2018 melalui Portal Bahagian Akaun KKM (surat ruj: 

KKM.BA/UAD/005 Jld.3 (3) bertarikh 25 Oktober 2018). 

 

2. Bagaimanakah PTJ dapat memastikan bayaran balik deposit kepada pendeposit 

dapat dilakukan? 

 

Jawapan 

 

PTJ hendaklah memastikan daftar deposit bagi kesemua akaun subsidiari (senarai 

pendeposit) bagi setiap kod deposit di PTJ masing-masing diselenggara dengan 

merujuk kepada Laporan di sistem iGFMAS seperti berikut: 

i. Laporan Kedudukan Baki Akaun Deposit (Menu Laporan) 

ii. Laporan Terimaan Terdahulu dan Deposit (Menu Terimaan) 

iii. Laporan Kedudukan Subsidiari (Menu Pengurusan Arahan 

Pembayaran) 
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3. Apakah yang menyebabkan baki buku tunai panjar wang runcit dan baki wang 

ditangan tidak sama? 

 

Jawapan 

Perbezaan mungkin disebabkan kesilapan amaun baucar kecil yang dikunci 

masuk. PTJ hendaklah memastikan baucar kecil yang dikunci masuk adalah tepat.  

 

Amaun baucar kecil yang terlebih dikunci masuk boleh dibatalkan sekiranya dibuat 

dalam bulan yang sama. Namun sekiranya telah melangkau bulan atau baucar 

kecil telah dibuat rekupmen, PTJ hendaklah memohon peranan capaian Terimaan 

Lain-Lain daripada Pejabat Perakaunan masing-masing (melalui Service Desk 

iGFMAS) bagi mengemaskini amaun sebenar dibawah kod akaun belanja yang 

berkenaan.  

 

4. Bagaimana cara untuk membuat penyelesaian awal baki pinjaman komputer / 

kenderaan Persekutuan atau pendahuluan diri terlebih emolumen? 

 

Jawapan 

 

Permohonan untuk mendapatkan penyata pengesahan baki terkini perlu 

dikemukakan melalui emel atau surat kepada Unit Subsidiari, Bahagian Akaun 

KKM.  

Bayaran penyelesaian boleh dibuat berdasarkan jumlah baki yang disahkan 

melalui wang tunai / bank draf di PTJ masing-masing. Resit perlu dikunci masuk 

di bawah kod akaun subsidiari (no. pelanggan & no. kontrak) peminjam yang 

berkenaan.  

Transaksi melalui Electronic Fund Transfer (EFT) hanya dapat dilakukan secara 

terus oleh pihak bank sahaja. Permohonan nombor akaun Bank Terimaan 

Bahagian Akaun KKM perlu dikemukakan melalui emel oleh pihak bank sendiri 

bersama-sama lampiran surat pengesahan baki pegawai berkenaan. Transaksi 

EFT daripada akaun individu adalah tidak dibenarkan. 
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5. Apakah tindakan susulan di peringkat PTJ setelah permohonan pendahuluan diri 

terlebih emolumen selesai diproses oleh Bahagian Akaun, KKM? 

 

Jawapan 

 

PTJ perlu menyediakan baucar jurnal (S5) dalam bulan yang sama setelah 

dimaklumkan secara emel oleh Bahagian Akaun, KKM. 

 

PTJ perlu menentukan sama ada kredit ke akaun hasil atau ke vot tahun semasa.  

Ianya adalah berdasarkan samada bagi bayaran terlebih emolumen berlaku pada 

tahun semasa atau pada tahun lalu / sebelumnya ataupun kombinasi kedua-

duanya.  Pendahuluan diri yang dibuat bagi mengutip balik terlebih bayar 

emolumen tahun semasa hendaklah dikredit ke vot B42 mengikut OS yang tepat, 

manakala bagi tahun sebelumnya hendaklah dikredit ke Akaun Hasil berkaitan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kod PTJ 

Membayar 

Kod PTJ 

Ditanggung 

Doc 

Type 
Dr/Cr Description Dana/Vot Segmen 

42XXXXXX 99101603 
S5 

Dr L1312947 E601 B7 

42XXXXXX 42XXXXXX Cr Hasil/Vot G000/B42 D4 
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iv. Kategori: EFT / Cek Terbatal / Bayaran Balik Hasil (B11) / 

BaucarJurnal 

 

1. Apakah tindakan yang perlu dilakukan oleh PTJ jika berlaku EFT/Cek Terbatal? 

 

Jawapan 

 

i. Kenal pasti samada EFT/Cek Terbatal perlu diganti atau dibuat pelarasan. 

 

ii. Jika perlu penggantian, sediakan Arahan Pembayaran EFT/Cek Terbatal 

(K9)/(K8) dengan maklumat penerima bayaran yang tepat. Penggantian 

hendaklah dilakukan dalam tempoh tujuh (7) hari. 

 

iii. Jika tanpa penggantian, sediakan Baucar Jurnal (KJ - Jurnal Biasa 

Pelarasan) ke Vot/Amanah. 

 

iv. EFT/Cek Terbatal yang tidak dituntut yang melebihi enam (6) tahun 

hendaklah diselaraskan melalui Baucar Jurnal ke Akaun Hasil H0181304 - 

EFT Terbatal/H0181303 - Cek Terbatal Tidak Dituntut. 

 

v. PTJ hendaklah menyelenggara dan mengemaskini Daftar Cek/EFT Terbatal. 

 

 

2. Adakah Bayaran Balik Hasil (B11) memerlukan resit asal? 

 

Jawapan 

 

 

Ya, sebarang permohonan bayaran balik hasil yang mana wang diterima adalah 

melibatkan pengeluaran resit rasmi kerajaan, maka permohonan bayaran balik 

hasil perlu mengemukakan resit asal selaras dengan SPANM Bil.3 Tahun 2019 

sebagai kawalan bagi mengelakkan tuntutan bayaran balik hasil lebih dari sekali. 
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3. Apakah tindakan PTJ jika berlaku kesilapan penggunaan kod vot/dana semasa 

transaksi bayaran atau terimaan? 

 

Jawapan 

 

PTJ perlu menyediakan Baucar Jurnal Antara Entiti jenis S5 apabila membuat 

pelarasan pembetulan yang melibatkan kod vot/dana. Contohnya, pelarasan 

pembetulan kesilapan penggunaan kod dana G000 kepada kod vot/dana 

Bxxx/Lxxx/Pxxx.  

Pelarasan boleh dibuat bagi Kod Kumpulan PTJ & PTJ Membayar yang berbeza 

dengan Kod Kumpulan PTJ & PTJ Menyedia dibawah Pejabat Perakaunan yang 

sama. Contohnya, PTJ Menyedia Bahagian Kewangan Hospital Putrajaya dengan 

PTJ Membayar Bahagian Farmasi Hospital Putrajaya di Pejabat Perakaunan 

KKM. 

 

4. Apakah tindakan PTJ bagi memastikan tiada ‘open item’ CIH (Wang Tunai Belum 

di Bankkan) bagi kutipan belum dibankkan atau kutipan yang telah dibankkan 

tetapi masih belum dibuat Penyata Pemungut (terimaan online)? 

 

Jawapan 

 

i. PTJ perlu memastikan semua terimaan di masukkan ke dalam Akaun Bank 

Kerajaan selaras dengan Arahan Perbendaharaan (AP) 78.  

ii. PTJ perlu memastikan Penyata Pemungut disediakan segera selaras 

dengan Arahan Perbendaharaan (AP) 79. 

iii. PTJ perlu menyemak Laporan Buku Tunai Cerakinan dari masa ke semasa. 

 

5. Adakah resit boleh dibatalkan melangkaui tahun yang berbeza? 

 

Jawapan 

 

Tidak. Pembatalan resit hendaklah dibuat segera melalui Baucar Jurnal 

Pembatalan Resit dan perlu dipastikan pembatalan dilakukan dalam tahun 

semasa. 

 

 

file:///C:/Users/Administrator/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/3HQF2GWZ/Lampiran%20Senarai%20Semak%20Pemantauan%20Operasi%20Pejabat%20Perakaunan/Laporan%20Buku%20Tunai%20Cerakinan.pdf
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v. Kategori: Waran Peruntukan 

 

1. Apakah yang boleh dilakukan oleh PTJ Tier 1 sekiranya berlaku kesilapan 

mengunci masuk waran semasa pengagihan menggunakan jenis urusniaga F1? 
 

Jawapan 

 

Sekiranya dokumen berstatus 80 (telah mempunyai nombor dokumen kawalan) 

dan peruntukan masih belum dibelanjakan, PTJ Tier 1 boleh membuat pembetulan 

dengan mengunci masuk jenis urusniaga F7 - WP Batal dan membatalkan 

keseluruhan dokumen atau; 

 

PTJ Tier 1 boleh membuat waran peruntukan tarik bagi menarik semula urusniaga 

yang tersilap diagihkan kepada PTJ Tier 2/3 dengan menggunakan jenis 

urusniaga F3 - WP Asal Tarik.  PTJ perlu meletakkan baris chargeline yang tersilap 

semasa F1 dan perlu menukar simbol (-). 

 

Seterusnya PTJ perlu mengagihkan semula WP kepada PTJ dengan 

menggunakan jenis urusniaga F1 (sekiranya ada). 

 

2. Apakah yang boleh dilakukan oleh PTJ Tier 2 sekiranya berlaku kesilapan 

mengunci masuk waran semasa pengagihan menggunakan jenis urusniaga F4? 
 

Jawapan 

 

Sekiranya dokumen berstatus 80 (telah mempunyai nombor dokumen kawalan) 

dan peruntukan masih belum dibelanjakan, PTJ Tier 2 boleh membuat pembetulan 

dengan mengunci masuk jenis urusniaga F7 - WP Batal dan membatalkan 

keseluruhan dokumen atau; 

 

PTJ Tier 2 boleh membuat waran peruntukan tarik bagi menarik semula urusniaga 

yang tersilap diagihkan kepada PTJ Tier 3 dengan menggunakan jenis urusniaga 

F5 - WP Kecil Tarik.  Bagi jenis urusniaga F5, PTJ perlu meletakkan baris 

chargeline iaitu chargeline PTJ yang ditarik i.e PTJ Tier 3, simbol (-) dan chargeline 

PTJ yang menerima i.e PTJ Tier 2, simbol (+). 

 

Seterusnya PTJ perlu mengagihkan semula WP kepada PTJ yang sepatutnya 

dengan menggunakan jenis urusniaga F4 (sekiranya ada). 
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3. Sekiranya PTJ Tier 1 telah mengagihkan WP kepada PTJ Tier2/3, adakah PTJ 

Tier2/3 perlu membuat Akuan Terima? 

 

Jawapan 

 

Tidak. Bagi jenis urusniaga F1 sehingga F3, PTJ TIDAK perlu membuat Akuan 

Terima. PTJ mendapatkan maklumat agihan daripada PTJ Tier 1 dan membuat 

semakan di Laporan Umum - Laporan Kedudukan Vot/Dana dan memasukkan kod 

PTJ Membayar i.e PTJ Menerima. 

 

4. Adakah PTJ Tier 3 perlu membuat Akuan Terima setelah agihan dibuat oleh PTJ 

Tier 2? 

 

Jawapan 

 

Ya. PTJ Tier 3 perlu membuat akuan terima setelah menerima WP daripada PTJ 

tier 2. Ini kerana semasa pengagihan dibuat PTJ Tier 2 telah memilih urusniaga 

F4 - WP kecil dan bagi urusniaga F4 - F5, PTJ perlu membuat Akuan Terima. 

 

5. Adakah PTJ perlu membuat WP - Kosong, F0 bagi gaji dan pukal? 

 

Jawapan 

 

Sekiranya agihan sempat dibuat menggunakan F1 atau F4 sebelum larian gaji dan 

bayaran pukal oleh Pejabat Perakaunan, maka PTJ tidak perlu membuat WP F0.  

 

Namun sekiranya agihan belum sempat dibuat, PTJ perlu menyediakan F0 bagi 

membolehkan perbelanjaan diproses semasa larian gaji dan pukal. 
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vi. Kategori: Perakaunan Aset Dan Inventori 

 

1. Bagaimanakah untuk menentukan kos pembaikan (ubahsuai / naiktaraf / 

penggantian) sesuatu aset sedia ada itu perlu dipermodalkan atau dibelanjakan? 
 

Jawapan 

 

Kos pembaikan bagi aset sedia ada perlu dipermodalkan dan diiktiraf sebagai 

Hartanah, Loji dan Peralatan sekiranya menepati salah satu (1) daripada  tiga (3) 

kriteria berikut: 
 

 

i. Meningkatkan kecekapan aset daripada fungsi asal aset semasa 

pembelian aset dilakukan; 
 

ii. Meningkatkan kapasiti pengeluaran/ penggunaan aset daripada kapasiti 

asal aset semasa pembelian dilakukan; 
 

iii. Meningkatkan usia guna aset selepas belanja pengubahsuaian berlaku. 

 

Semasa membuat permohonan peruntukan, Pegawai Teknikal di PTJ hendaklah 

mengenalpasti samada peruntukan dibawah OS30000 atau OS20000 bagi projek 

ubahsuai/naik pembaikan yang bakal dilaksanakan. Kos tersebut 

dipertanggungkan di bawah peruntukan OS30000 dan perlu dipermodalkan 

dengan diakaunkan kepada kos A1430000. Sekiranya kos pembaikan tidak 

memenuhi salah satu (1) daripada tiga (3) kriteria tersebut, maka ianya direkod 

sebagai belanja dengan kod akaun B0220000. 

 

2. Apakah aset yang tidak perlu dipermodalkan? 
 

Jawapan 

 

Berdasarkan Polisi Perakaunan Akruan, terdapat aset yang tidak perlu 

dipermodalkan seperti berikut: 
 

i. Semua jenis aset yang bernilai kurang daripada RM2,000 per unit. Kod 

akaun yang perlu digunakan adalah B0335XXX. 
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ii. Aset yang dibiayai dari Dana Akaun Amanah Awam (Seksyen 9). Kod 

akaun yang perlu digunakan adalah B0335XXX; 
 

iii. Aset yang dibeli/dibina untuk diserahkan kepada pihak ketiga. Kod akaun 

yang digunakan adalah B033X333; dan 
 

iv. Item ketara yang tidak menepati definisi aset di bawah MPSAS 17 iaitu 

tujuan pegangan item tersebut tiada kaitan dengan salah satu (1) dari 

empat (4) kegunaan yang berikut. Sila gunakan kod akaun B033X444: 

a. Pengeluaran atau bekalan barangan 

b. Penyampaian perkhidmatan 

c. Sewaan kepada pihak lain 

d. Pentadbiran 

 

 

3. Apakah inventori KKM? Semasa membuat perolehan inventori, apakah kod akaun 

yang perlu digunakan?  
 

Jawapan 

 

Inventori KKM terdiri daripada empat (4) item iaitu: 

i. Ubat 

ii. Reagen 

iii. Vaksin 

iv. Bukan Ubat/Consumables 
 

Semasa perolehan, PTJ Inventori perlu menggunakan kod akaun B0627xxx (Kos 

Barang Digunakan) bagi empat (4) item di atas sahaja. Manakala lain-lain PTJ 

yang membuat perolehan item inventori perlu menggunakan Kod Akaun B0227xxx 

(Bekalan dan Perkhidmatan). 
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4. Adakah aset yang diterima daripada pihak luar perlu diakaunkan? Bagaimana 

prosedur untuk merekodkan aset hadiah? 
 

Jawapan 

 

Aset hadiah bernilai RM2,000 ke atas perlu diakaunkan apabila aset diterima dan 

telah menerima kelulusan daripada Pihak Berkuasa Melulus iaitu: 
 

i. KSU bagi amaun melebihi RM10,000; ataupun  
 

ii. Pengarah JKN/HKL bagi amaun kurang daripada RM10,000. 

 

Aset hadiah perlu diperakaunkan di dalam sistem iGFMAS dengan tatacara 

berikut: 
 

i. Wujudkan ID aset  
 

ii. Akaunkan melalui jurnal menggunakan Modul Perolehan Aset dengan kod 

akaun berikut: 
 

 

Dt.     Aset  (A143000) 
 

Kt. Terimaan Sumbangan Aset (H0186100) 

 

Garis panduan Perakaunan Aset Hadiah KKM boleh dimuat turun melalui portal 

Bahagian Akaun KKM http://account.moh.gov.my/v4/perakaunan-akruan/garis-

panduan 

 

5. Apakah maksud pelupusan aset dalam perakaunan akruan? Bagaimana merekod 

pelupusan aset dalam iGFMAS? 

 

Jawapan 

 

Pelupusan bermaksud aset dijual/dibuang sebagai tiada nilai pada akhir usia. 

Pelupusan boleh dilaksanakan: 
 

i. Secara penuh (keseluruhan aset); 

http://account.moh.gov.my/v4/perakaunan-akruan/garis-panduan
http://account.moh.gov.my/v4/perakaunan-akruan/garis-panduan
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ii. Pelupusan sebahagian iaitu melupuskan sebahagian daripada aset 

contohnya enjin kenderaan. 

 

Pelupusan aset melalui kaedah write off iaitu melupuskan nilai buku bersih aset 

dan perlu diperakaunkan di dalam sistem iGFMAS dengan kod akaun berikut: 

 

Dt.   Hapuskira        (B055XXX) 
 

Dt.   Susutnilai aset (A313XXX) 
 

Kt.   Aset (A143XXX) 
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vii. Kategori: Authorization  

 

1. Bagaimana cara pegawai (pemohon) di PTJ memohon / mengemaskini / membatal 

capaian iGFMAS? 
 

Jawapan 

 

Pegawai (pemohon) di PTJ hendaklah mengemukakan Borang Permohonan 

Capaian Pengguna Dan Had Kuasa Pusat Tanggungjawab (PTJ) - KEW.290E-01-

PIN.1/18 melalui iGFMAS Service Desk. Borang ini digunapakai bagi permohonan 

berkaitan capaian pengguna iGFMAS seperti berikut: 

i. Baharu 

ii. Kemaskini 

iii. Hapus 

iv. Hapus (Nombor Kad Pengenalan Salah) 

v. Pertukaran Masuk 

vi. Pertukaran Keluar 

vii. Lock (ID Pengguna) 

viii. Unlock (ID Pengguna) 

ix. Baharu (PTJ Admin - eResit) 

x. Hapus (PTJ Admin - eResit) 

 

2. Apakah tindakan yang perlu dilakukan sekiranya terdapat pengguna iGFMAS 

yang bertukar keluar/ bersara? 
 

Jawapan 

 

Pengguna iGFMAS yang bertukar keluar/ bersara perlu mengemukakan Borang 

Permohonan Capaian Pengguna Dan Had Kuasa Pusat Tanggungjawab (PTJ) - 

KEW.290E-01-PIN.1/18 (muka hadapan sahaja) yang lengkap ditandatangan oleh 

Pemegang Waran Peruntukan/ Ketua Jabatan kepada Bahagian Akaun melalui 

iGFMAS Service Desk. 
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3. Apakah tindakan yang perlu dilakukan sekiranya terdapat pengguna iGFMAS 

yang bertukar masuk/ pengguna iGFMAS baharu yang ingin memohon capaian 

iGFMAS? 

 

Jawapan 

 

Pengguna iGFMAS yang bertukar masuk/ pengguna iGFMAS baharu perlu 

mengemukakan dokumen berikut melalui iGFMAS Service Desk bagi memohon 

capaian iGFMAS: 

 

i. Borang Permohonan Capaian Pengguna Dan Had Kuasa Pusat 

Tanggungjawab (PTJ) - KEW.290E-01-PIN.1/18 yang lengkap ditandatangan 

oleh Pemegang Waran Peruntukan/ Ketua Jabatan. 

 

ii. Salinan kad pengenalan (bagi pegawai baharu). 

 

iii. Salinan Kebenaran Khusus Secara Bertulis yang ditandatangani oleh Ketua 

Jabatan seperti berikut (sekiranya berkaitan dengan peranan yang dipohon): 

 

a. Borang AK52 Kuasa Tetap Panjar Wang Runcit dan Panjar Khas 

(seperti di Lampiran A8: Surat Pekeliling Akauntan Negara Bilangan 6 

Tahun 2018); 

b. Borang Kew. 290 Pin.1/17 Arahan Perbendaharaan 101 Pegawai-

Pegawai Memperaku Dan Menandatangani Baucar (seperti di Lampiran 

A9 : Surat Pekeliling Akauntan Negara Bilangan 6 Tahun 2018) bagi 

PTJ manual sahaja; 

c. Borang Kebenaran Khusus Secara Bertulis Melaksanakan Penetapan 

Kuasa Dan Tugas Pegawai Pengawal/Pemungut - Pejabat Pemungut 

seperti di Lampiran B: Surat Pekeliling Akauntan Negara Bilangan 6 

Tahun 2018). 
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4. Dimana pengguna iGFMAS di PTJ boleh dapatkan Borang Permohonan Capaian 

Pengguna Dan Had Kuasa Pusat Tanggungjawab (PTJ) - KEW.290E-01-

PIN.1/18? 

 

Jawapan 

 

Borang Permohonan Capaian Pengguna Dan Had Kuasa Pusat Tanggungjawab 

(PTJ) - KEW.290E-01-PIN.1/18 boleh dimuat turun di saluran seperti berikut: 

 

i. Laman web rasmi Jabatan Akauntan Negara Malaysia 

http://www.anm.gov.my pada menu Perkhidmatan -> Muat turun -> Borang-

Borang. 
 

ii. Laman web rasmi Bahagian Akaun Kementerian Kesihatan Malaysia 

http://account.moh.gov.my/ pada menu Muat turun. 

 

5. Mengapakah dokumen kewangan tiada di Senarai Tugas Harian (STH) pengguna 

iGFMAS? 

 

Jawapan 

 

Dokumen tiada di STH berpunca daripada pengguna iGFMAS berkenaan tidak 

diberi peranan Peraku I / Peraku II / Akuan Terima di PTJ. 

 

PTJ perlu wujudkan incident di iGFMAS Service Desk dengan menyatakan 

masalah dan maklumat  seperti contoh berikut:  

 
Isu : Dokumen Tiada DI STH Peraku 2 

ID Peraku 2   : 820308041111 

Proses    : Arahan Pembayaran 

Pejabat Perakaunan : 1107 

PTJ : 42240201 

No Dokumen              : 12000592 

Tarikh dokumen        : 06.02.2018 
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viii. Kategori: Teknikal 

 

1. Tidak dapat akses ke web iGFMAS 

Jawapan 

 

i. Masuk Tools>Compability View Setting>klik Add untuk website  

anm.gov.my >Klik Close 

ii. Tools>Internet Options>Advance>Settings>Tick TLS 1.1, Use SSL 2.0 

dan Use SSL 3.0 

Klik Apply > Klik OK 

 

 

 

 

 

 

 

 

Tick Use SSL 2.0, 

Use TLS 1.0, Use 

TLS 1.1 & Use TLS 

1.2 
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2. Semasa klik ikon   SAP Logon, paparan pada SAP Logon tidak wujud folder 

iGFMAS 

 

 

 

 

 

 

Jawapan 

 

i. Jika folder 1GFMAS pada SAP Logon seperti gambar dibawah tidak wujud 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

Klik 

PERAKAUNAN 

AKRUAN > Muat 

Turun 

Klik ikon 

untuk muat 

turun fail 

Common.zip 
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ii. Klik Save 

  

 

 

 

 

 

  

iii. Klik My Computer pada desktop > Klik ikon Downloads pada sebelah kiri 

My Computer, seterusnya double click Common.zip 

  

 

 

 

 

 

 

iv. Right click pada file Common yang telah di unzip tadi. Klik Copy. 
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v. Masuk My Computer > Klik Organize > Klik Folder and search option >  Klik 

tab View > Tick Show hidden files, folders & drives > Klik Apply > Klik OK. 

 

 

 

 

 

 

 

 

  
vi. Klik My Computer > Drive C: > Users> User > AppData > Roaming > 

SAP 

 

 

 

vii. Paste satu folder Common yang telah di copy daripada fail Common.zip 

yang telah di unzip tadi dan paste ke folder SAP tersebut. 

 

viii. Pengguna boleh klik  kembali ikon SAP Logon dan klik OK sekiranya pop 

up mesej seperti gambar di bawah: 
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ix. SAP Logon sudah dikemaskini dan terdapat file iGFMAS pada ruangan kiri 

SAP Logon 

 

 

 

 

 

 

 

3. Ralat “500 SAP Internal Server Error” 

 

Jawapan 

 

Contoh ralat pada portal sekiranya pengguna klik bahagian tab Terimaan iaitu 500 

SAP Internal Server Error seperti gambarajah di bawah: 

 

 

 

 

 

 

 

 

Pengguna perlu re-login portal iGFMAS masukkan sekali lagi username dan 

password. 
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4. Ralat  DSM Terminator [ABORT] 

 

Jawapan 

 

Contoh ralat seperti DSM Terminator [ABORT] seperti gambarajah: 

 

 

 

 

 

 

 

 

 

 

i. Pengguna perlu turn off  popup blocker 

 

ii. Klik Tools > Pop-up Blocker > Turn off Pop-up Blocker 
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5. Senarai Tugas Harian tidak boleh diklik. 
 

 Jawapan 

 

(Untuk Windows 10 Pro Build 1703 dengan IE11 KB4012204 dan ke atas) 

 

Check Windows Updates untuk Windows 10 dan biarkan update (termasuk 

Cumulative Security Update) tersebut running. 

 

Selepas update Windows selesai, pengguna iGFMAS boleh akses portal tersebut 

dengan jayanya. 

 

6. Paparan simbol “No Entry” Ø pada portal iGFMAS ketika pengguna klik tab. 

 

Jawapan 

 

i. Install java pada PC pengguna yang telah mengalami masalah seperti di 

atas. 

 

ii. Selepas selesai instalasi, PC perlu restart dan log masuk kembali ke portal 

iGFMAS. 

 

iii. Alamat URL bagi muat turun fail java ialah:  

https://www.java.com/en/download/ie_manual.jsp 

https://www.java.com/en/download/ie_manual.jsp
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7. Masalah GPKI: Tandatangan Tidak Sah 

 

Jawapan 

 

i. Pastikan semua GPKI lama telah uninstall. (Start>Control 

Panel>Programs and Features) 

 

ii. Buka portal rasmi Bahagian Akaun: https://account.moh.gov.my  
 

iii. Klik mouse-over tab Perakaunan Akruan dan klik Muat Turun. 

 

 

 

 

 

 

 

 

 

iv. Klik ikon  pada  Bil 7 Pautan Mampu GPKI Agent. 

 

https://account.moh.gov.my/
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v. Download Mampu GPKI Agent tersebut dengan memasukkan no. MyKad 

pengguna yang sah. 

  

 

vi. Buka folder tersebut dan Run as administrator Mampu GPKI Agent  

 

vii. Buka kembali portal iGFMAS, log masuk portal tersebut. 
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